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Author Questionnaire:
1. Microscopy: Does your protocol involve video microscopy? N
2. Does your protocol include software usage? Y
If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps.
3. Which steps from the protocol section below will viewers benefit most from having filmed? 2.4, 3.1, 3.3, 3.8, 3.9, 3.10.
4. What is the single most difficult aspect of this procedure and what do you do to ensure success? 3.1, 3.3, 3.8, 3.10 (3.1.2, 3.3.1, 3.8.3, 3.10.2 only) Generally, speed and accuracy in filling the wells by the antibodies, blocking agent, and samples. One should practice these steps multiple times with dummy samples before moving to handling clinical samples.
5. Will the filming need to take place in multiple locations? N

Section - Introduction
Videographer: Interviewee Headshots are required. Take a headshot for each interviewee.
REQUIRED Interview Statements: (Said by you on camera) - All interview statements may be edited for length and clarity.
Tony Y. Hu: Nanoplasmon-enhanced scattering, or nPES, is a simple and non-invasive alternative to surgical biopsies that circumvents time-consuming and labor-intensive exosome purification steps, expanding the application of exosome analysis to clinical settings. [1]
1.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
Pouya Amrollahi: This nPES-based assay is a rapid procedure to analyze specific biomarkers on the outer membrane of exosomes that does not require separate isolation and purification steps. [1]
1.1.2. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.


OPTIONAL Interview Statements: (Said by you on camera) - All interview statements may be edited for length and clarity.
[bookmark: _Hlk356954]Tony Y. Hu: We only need a very small clinical sample for this assay. Therefore, this assay expands the use of nPES to studying genetically-engineered or patient-derived xenograft mouse models. [1]
1.1.3. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
[bookmark: _Hlk356962]Pouya Amrollahi: There are a few steps in this protocol that might seem daunting. However, with a few practice-runs, everyone with basic wet-lab skills can learn to successfully perform nPES. [1]
1.1.4. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.

1.1.5. 

Section - Protocol
2. Preparation of Nanoparticle Probes (AuNR-IgG)
To begin the procedure, combine 40 microliters of a suspension of neutravidin-functionalized (noo-trav-ih-din funk-shun-uh-lized /nuːˈtræv ɪ dɪn ˈfʌŋk ʃən əˌlaɪzd/) gold nanorods (nan-oh-rods /ˈnæn ɵˌrɒds/) with 200 microliters of cold pH-7 phosphate-buffered (foss-fate /ˈfɒs feɪt/) saline (say-leen /ˈseɪ liːn/). [1-TXT]
2.1.1. MED: Talent transfers 40 µL of AuNR-AV and 200 µL of PBS to a clean tube, closes the tube, and vortexes the mixture. TEXT: Start AuNR-IgG preparation during slide blocking; 6.4 × 1012 AuNR-AV/mL (See text for details)
Centrifuge the mixture at 8,500 × g at 4 degrees Celsius for 10 minutes and remove the supernatant (soop-er-nate-ənt /ˌsuːp ərˈneɪt ənt/). Repeat this washing process twice more, [1] and then suspend the nanorods in 40 microliters of cold PBS (P-B-S). [2-TXT]
2.1.2. MED: Talent removes a tube of already-centrifuged AuNR-AV and PBS from the centrifuge, opens the tube, and starts removing the supernatant.
2.1.3. MED: Talent adds 40 µL of PBS to a tube containing a pellet of washed AuNR-AV and disperses the nanorods in PBS. TEXT: All cold PBS at 4 °C
Next, add 150 microliters of cold PBS and 10 microliters of a 0.5 milligram-per-milliliter solution of the appropriate biotinylated (by-uh-tin-ih-late-əd /ˌbaɪ əˈtɪn ɪ̈ leɪt əd/) antibodies to the suspension. [1-TXT] Mix at 4 degrees Celsius for 2 hours to obtain antibody-conjugated gold nanorods. [2]
2.1.4. MED: Talent adds 150 µL of PBS and 10 µL of IgG to the tube containing the nanorods dispersed in PBS and closes the tube. TEXT: See text for antibody details Video Editor: Please wait to show the text overlay until “10 microliters…” is spoken in the voice-over.
2.1.5. MED: Talent places the tube in the mixer holder, starts the mixer, and closes the refrigerator.
Wash the nanorods three times by centrifugation (sent-trih-fyu-geish-un /ˌsɛn trɪ̈ fjʊˈgeɪʃ ən/) in 200-microliter portions of cold PBS at 6,500 × g at 4 degrees Celsius for 10 minutes each. [1]
2.1.6. MED: Talent removes a tube containing already-centrifuged AuNR-IgG from the centrifuge, removes the supernatant from the tube, adds 200 µL of PBS, and starts re-suspending the nanorods in PBS. Videographer: Please get 7-8 seconds of additional footage of the washing process to be used in the next section.
Afterwards, suspend the washed antibody-conjugated nanorods in 200 microliters of cold PBS [1] and store them at 4 degrees Celsius for up to 24 hours. [2]
2.1.7. CU: Talent adds 200 µL of PBS to a tube containing washed AuNR-IgG and resuspends the nanorods in PBS.
2.1.8. MED: Talent places the tube of prepared AuNR-IgG in a refrigerator and closes the refrigerator.
3. Preparation of Extracellular Vesicle Capture Slides and Exosome Capture
To begin preparing the slide, dilute the desired exosome (eks-o-sohm /ˈɛks ɵˌsoʊm/) capture antibodies to 0.025 milligrams per milliliter in PBS. [1-TXT] Pipette 1 microliter of this solution into each well of a protein A/G-treated (protein-A-G treated) slide backed with optical-grade glass. [2]
3.1.1. MED: Talent adds PBS to the exosome capture antibodies, closes the tube, and vortexes it. TEXT: Vortex at maximum vibration speed
3.1.2. MED: Talent uses a repeater pipette to add 1 µL of capture antibodies to each well in a column on the slide.
3.1.3. MED: Talent transfers the slide to a humidifying box to ensure wells do not dry up during incubation.	Comment by Pouya Amrollahi: Added a shot that will need some voice over narration.
Incubate the slide at 37 degrees Celsius for 1 hour to immobilize the capture antibodies. [1] Then, aspirate (asp-ih-rate /ˈæsp ɪˌreɪt/) the remaining solution to remove unbound antibodies. [2] Wash the wells by adding and aspirating (asp-ih-rate-ing /ˈæsp ɪˌreɪt ɪŋ/) 1 microliter of PBS three times. [3]
3.1.4. MED: Talent places the filled slide in the incubator, closes the incubator, and moves away as though leaving the slide for an hour.
3.1.5. MED: Talent uses a vacuum system to aspirate one column of wells.
3.1.6. MED: Talent finishes filling one column of wells with PBS and starts aspirating the wells. Videographer: Please get at least 6-7 seconds of footage for this shot.
Next, quickly load each well with 1 microliter of PBS-based blocking buffer [1] and incubate the slide at 37 degrees Celsius for 2 hours. [2]
3.1.7. MED: Talent uses a single-channel pipette to load blocking buffer into the last column of wells to finish filling the plate. Videographer: Please get at least 8-9 seconds of footage for this shot.
3.1.8. MED: Talent places the filled plate in the incubator and closes the incubator door.
Pouya Amrollahi: When running around 15 samples, we must use a single-channel pipette to load blocking buffer onto 120 wells in less than 5 minutes to avoid the evaporation of blocking agent. [1]
3.1.9. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
Start preparing a solution of antibody-conjugated gold nanorods during slide blocking. [1] About 30 minutes before blocking finishes, rapidly thaw plasma or serum (seer-um /ˈsɪər ʌm/) samples in a room-temperature water bath. [2]
3.1.10. Use extra 2.4.1 footage.	Comment by Pouya Amrollahi: Did not film as noted to use from previous shot.
3.1.11. MED: Talent places at least one frozen serum or plasma sample in a room-temperature water bath to thaw.
[bookmark: _Hlk485648004]Vortex the thawed samples for 30 seconds to ensure that the suspensions are homogeneous (home-uh-jeen-ee-us /ˌhoʊm əˈʤiːn iː əs/). [1] Then, centrifuge the samples at 500 × g for 15 minutes to precipitate (preh-sip-ih-tate /prəˈsɪp ɪˌteɪt/) protein aggregates (ag-gruh-gits /ˈæg grə gɪts/) and other debris. [2]
3.1.12. MED: Talent removes a thawed sample from the water bath and repeatedly inverts it to produce a homogenous suspension.
3.1.13. MED: Talent places at least one well-mixed, thawed sample in a centrifuge, closes the centrifuge, and starts it at 500 × g.
Transfer 10-microliter aliquots (al-ih-kwots /ˈæl ɪˌkwɒts/) of the supernatants to fresh tubes [1] and make 1-to-1 dilutions with PBS. Mix the diluted samples by gentle vortexing or inversion, as appropriate. [2]
3.1.14. CU: Talent transfers an aliquot of supernatant from an already-centrifuged sample to a new tube.
3.1.15. MED: Talent adds PBS to the tube containing the sample aliquot, closes the tube, and mixes it by gentle vortexing.
[bookmark: _Hlk480795708]When slide blocking has finished, [1] aspirate the blocking buffer and wash the wells three times with 1-microliter portions of PBS. [2] Immediately load the samples into the wells, with 1 microliter per well and eight replicates (rep-lih-kits /ˈrɛp lə kɪts/) per sample. [3]
3.1.16. MED: Talent removes a blocked slide from the incubator.
3.1.17. MED: Talent aspirates blocking buffer from the slide and then starts adding PBS to the first column. Videographer: Please get at least 7-8 seconds of footage for this shot.
3.1.18. MED: Talent loads a sample into eight wells of the plate.
Load exosome standards into the appropriate wells in the same way. [1-TXT] Incubate the slide for 12 to 18 hours in a refrigerator at 4 degrees Celsius. [2]
3.1.19. MED: Talent loads a standard solution into the appropriate wells on the plate. TEXT: See text for exosome standard preparation
3.1.20. WIDE: Talent brings the sample plate to the refrigerator, places it in the refrigerator, and closes the refrigerator.
Then, aspirate the wells and wash each well once with 1 microliter of PBS. [1] Load 1 microliter of the antibody-conjugated gold nanorod suspension into each well [2] and incubate the slide at 37 degrees Celsius for 2 hours. [3]
3.1.21. MED: Talent loads PBS into a column of the plate and aspirates it.
3.1.22. MED: Talent loads AuNR-IgG suspension into the last column of wells on the plate with a repeater pipette.
3.1.23. MED: A view of the filled plate in the incubator, with the incubator temperature display visible if possible.
Afterwards, aspirate the nanorod suspension and wash the slide in PBS supplemented with 0.01% polysorbate 20 (pall-ee-sorb-ate twenty /ˌpɒl iːˈsɔːrb eɪt/) for 10 minutes using a mixer. [1]
3.1.24. MED: Talent places the slide in PBS supplemented with Tween 20, secures the container on the mixer, and starts the mixer.
Then, aspirate the wells and wash the slide in deionized water for 10 minutes on a rotating mixer. [1] Remove the water and allow the slide to air-dry in a clean Petri (peet-tree /ˈpiː triː/) dish before bringing the slide to the dark-field microscope. [2]
3.1.25. MED: Talent places the slide in DIH2O, secures the container on the rotating mixer, and starts the mixer.
3.1.26. MED: Talent aspirates DIH2O from the slide and places the slide in a clean Petri dish to dry.
4. Low-Magnification Dark-Field Microscope (LMDFM) Image Acquisition and Analysis
Set up an inverted microscope equipped with a dark-field oil-immersion condenser, a 4X (four-X) objective, and a motorized stage. [1-TXT] Connect the microscope to a computer via a digital camera and open the imaging software. [2-TXT]
4.1.1. WIDE: Talent approaches the microscope and turns on the associated computer, camera, light source, etc. TEXT: 1.2 < NA < 1.4; 1/220 s exposure time
4.1.2. MED-Over shoulder: An over-shoulder view of the computer screen as talent opens the NIS Elements software and sets the input source to be the camera and/or microscope. TEXT: See text for software details
Then, place the sample slide upside-down on the microscope stage [1] and apply a small drop of immersion oil where the condenser lens contacts the slide. [2]
4.1.3. MED: Talent places the sample slide on the stage.
4.1.4. ECU: Talent applies a drop of immersion oil to the back of the slide where it meets the condenser lens.
Display the view through the microscope in the imaging software. Adjust the exposure time against a high-concentration standard well to ensure that the image will not be saturated. [1]
4.1.5. SCREEN: To be provided by the authors – A single screen capture video file showing the following series of actions, in sequence:
1. Click the live button and use either automatic or manual exposure controls (as appropriate) to adjust the image for optimal exposure. Authors: Please fill in the time in the screen capture file when you finished this series of actions: 00:20____ (Timestamp 1)
2. Then, navigate to Acquire > Scan Large Image, use the cursor to point out that both the Macro Image and Scanning optical configurations are set to Current, set both objectives to 2: 10x, click the Close active shutter during stage movement and Wait before each capture tick-boxes, and fill in 20 in the corresponding text box. Authors: Please fill in the time in the screen capture file when you finished this series of actions: ____ 01:05 (Timestamp 2)
3. Then, set the Stitching Overlap to 20%, select Optimal Path from the Stitching via dropdown menu, click the Create large image radio button, click the Focus manually at start and Use step-by-step focus tick-boxes, select every…field, and fill in 20 in the corresponding text box. Authors: Please fill in the time in the screen capture file when you finished this series of actions: ____ 01:33 (Timestamp 3)
4. Then, select Left, top, right, and bottom limits from the Area drop-down menu and start driving the stage towards one of the limits.
Authors, please upload this screen capture to your project page.
Video Editor: Please transition from step 4.3 to 4.4 at timestamp 1, from 4.4 to 4.5 at timestamp 2, and from 4.5 to 4.6 at timestamp 3.
Then, open the tool for scanning large images and set the objective magnification to 10X (ten-X). Choose to close the active shutter during stage movement and to wait 20 milliseconds before each capture. [1]
4.1.6. SCREEN: Sequence 2 in the 4.3.1 screen capture (from timestamp 1 to timestamp 2).
Set the stitching overlap to 20% and select stitching via the optimal path. Choose to create a large image from the scan. Set the camera to focus manually at the start of the scan and enable automatic step-by-step focus every 20 fields. [1]
4.1.7. SCREEN: Sequence 3 in the 4.3.1 screen capture (from timestamp 2 to timestamp 3).
Then, choose to set left, right, top, and bottom limits for the target scan field and define the scan area [1] by moving the microscope stage to each of the desired limits. [2]
4.1.8. SCREEN: Sequence 4 in the 4.3.1 screen capture (from timestamp 3 to the end of the video).
4.1.9. SCREEN: To be provided by the authors – Finish driving the stage towards the limit from the above sequence, click the corresponding arrow, and then start driving the stage to another limit. Authors, please upload this screen capture to your project page.
Next, adjust the focus, the condenser, and the area lighting to obtain [1] a clear, well-lit image. Name the image file to be created and start the scan. [2] When it finishes, open the image and save it at one-eighth scale. [3]
4.1.10. SCREEN: To be provided by the authors – With the scan area now defined, start adjusting the condenser settings. Authors, please upload this screen capture to your project page.
4.1.11. SCREEN: To be provided by the authors – With the image now clear and well-lit, use the cursor to point out the image. Then, name the image output file and click Scan. Authors, please upload this screen capture to your project page.
4.1.12. SCREEN: To be provided by the authors – Show the scan finishing, and then open the image and save it at 1/8th scale. Authors, please upload this screen capture to your project page.
Open the image analysis software and run the DSM (D-S-M) macro. Ensure that the contour threshold is 253.020, the center scale is 0.8, the type is red, and the low and high quantification limits are 0 and 62, respectively. [1-TXT]
4.1.13. SCREEN: To be provided by the authors – A single screen capture video file showing the following series of actions, in sequence:
1. Open the Plugins menu, click the DSM menu entry, and use the cursor to point out the following items, in sequence: the Contour Threshold value of 253.020, the Center Scale value of 0.800, the Type dropdown menu showing Red, and the Low limit and High limit values of 0 and 62, respectively. Authors: Please fill in the time in the screen capture file when you finished this series of actions: ____ (Timestamp 1)
2. Then, click the Single mode tick-box, use the cursor to point out the Output Filtered Images and Strong Signal options (or click them if applicable), click OK, navigate to the scanned image in the file browser (and select the output folder if applicable), select the scanned image, and wait as the algorithm runs. Authors: Please fill in the time in the screen capture file when you finished this series of actions: ____ (Timestamp 2)
3. Then, open the Plugins menu, click DSM Scan, define the number of columns and rows, set Resize Percentage to 25, set Spot Diameter (in pixels) to 190-200, set Diameter Range to 32, and set Increment diameter (in pixels) to 8. Authors: Please fill in the time in the screen capture file when you finished this series of actions: ____ 00:30 (Timestamp 3)	Comment by Pouya Amrollahi: This is the part that should be narrated at 06:51 to 07:45.
4. Then, set Low limit to 0, High limit to 62, Adjacent Distance to 100, and Subtract Bias to 0, and then click OK to process the image.
Authors, please upload this screen capture to your project page.
Video Editor: Please transition from step 4.8 to 4.9 at timestamp 1, from 4.9 to 4.10 at timestamp 2, and from 4.10 to 4.11 at timestamp 3. Please also show this text overlay while “Next, open the image analysis software and run the DSM macro” is spoken in the voice-over of step 4.8: TEXT: See text for DSM macro installation
Select Single mode to process a single image and choose additional processing options if appropriate. Select the scanned image, set the output folder if necessary, and wait for the algorithm to finish. [1]
4.1.14. SCREEN: Sequence 2 in the 4.8.1 screen capture (from timestamp 1 to timestamp 2).
Then, open the DSM Scan window and set the number of columns and rows to match the slide. Set the resize (re-size) percentage to 25, the spot diameter to 190 to 200, the diameter range to 32, and the increment diameter to 8. [1]
4.1.15. SCREEN: Sequence 3 in the 4.8.1 screen capture (from timestamp 2 to timestamp 3).
Set the low and high DSM limits to 0 and 62, the adjacent distance to 100, and the subtraction bias to 0. Run the DSM algorithm and save the resulting data. [1]
4.1.16. SCREEN: Sequence 4 in the 4.8.1 screen capture (from timestamp 3 to the end of the video).


Section – Results
5. Results: Exosome Quantification by Analysis of LMDFM Images
The DSM analysis technique showed good reproducibility (ree-pruh-doose-ih-bill-it-ee /ˌriː prə duːs ɪ̈ˈbɪl ɪt i/) across serially-diluted PANC-1 (pank-one /ˈpæŋk/ (sounds like bank)) exosome samples ranging from 0.24 to 1.2 micrograms per microliter. [1] A strong linear correlation was observed [2] between the scatter response from the gold nanorods [3] and the exosome protein concentration. [4]
5.1.1. LAB MEDIA: Figure 4A – Video Editor: Please add under each column, from left to right, ‘0 µg/µL’, ‘0.24’, ‘0.356’, ‘0.53’, ‘0.80’, and ‘1.20’. Please also add the caption ‘Captured with anti-EphA2 antibody; Detected with anti-CD9 antibody’.
5.1.2. LAB MEDIA: Figure 4B – Video Editor: Highlight the diagonal blue line spanning the blue data points (the linear trendline).
5.1.3. LAB MEDIA: Figure 4B – Video Editor: Highlight the y-axis title (‘Optical response’).
5.1.4. LAB MEDIA: Figure 4B – Video Editor: Highlight the x-axis title (‘Concentration (mg/ml)’).
A significant difference in abundance of serum exosomes expressing the cancer-associated biomarker (by-oh-mark-er /ˈbaɪ ɵˌmɑːrk ər/) EphA2 (E-P-H-A-two) was observed [1] between patients with pancreatic (pank-kree-at-ik /ˌpæŋkr iːˈæt ɪk/) cancer [2] and healthy patients. [3]
5.1.5. LAB MEDIA: Figure 5 – Video Editor: Highlight the bracket with two asterisks over it (the asterisks denote a significant difference between the two datasets).
5.1.6. LAB MEDIA: Figure 5 – Video Editor: Highlight the red dots and the red lines on the ‘Pancreatic Cancer’ side of the plot.
5.1.7. LAB MEDIA: Figure 5 – Video Editor: Highlight the green dots and green lines on the ‘Healthy’ side of the plot.

Section - Conclusion
6. Conclusion Interview Statements: (Said by you on camera) - All interview statements may be edited for length and clarity.
Pouya Amrollahi: From the addition of blocking agent onward, fast and accurate pipetting is crucial to avoid the evaporation of samples, introducing cross-contamination, and scratching the surface of the slide. [1]
6.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera. Video Editor: Step 3.3 is the addition of blocking agent to the slide. Related shots include 3.3.1, 3.8.3, and 3.10.2. 
Tony Y. Hu: Following this procedure, we perform statistical analysis to investigate any correlation between the expression of the exosomal marker of interest and different stages of the disease that is being studied. [1]
6.1.2. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
[bookmark: _Hlk357401]Tony Y. Hu: After establishing this technique, we were able to find an exosomal biomarker for early-stage pancreatic cancer. Currently, we are expanding these discoveries to other types of cancer and infectious diseases. [1]
6.1.3. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
[bookmark: _Hlk357414]Pouya Amrollahi: Usually the samples handled in this assay are either patient samples or purified exosome samples from cancer cell lines, which necessitate special safety training. [1]
6.1.4. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.



 2018, Journal of Visualized Experiments	Page 1 of 16
image1.png




